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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 1993-2008 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows NT®, and Windows® XP are U.S. registered trademarks of Microsoft 
Corporation.  

Windows VistaTM is either a registered trademark or trademark of Microsoft Corporation in the United 
States and/or other countries. 

Java™ is a US trademark of Sun Microsystems, Inc. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 
countries. 

For additional trademark information, see the “Copyright” chapter in the Reference Guide.  
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Enterprise Discovery 

Release Notes 
Software version: 2.51 / March 2008 

This document provides an overview of the changes made to Enterprise Discovery for version 2.51. It 
contains important information not included in the manuals or in the online help. 

In This Version

New Features

Obsolete Features 

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.51. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.50, 2.2x and 2.1.x.  

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.1.x, 2.2x, and 2.50), you can read the Release Notes for those versions, available on your 
installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data from a maximum of 50,000 discovered devices and 60,000 
devices in total. The port limit is 150,000 ports (whichever comes first). An Enterprise Discovery Aggregator 
can support 50 servers and up to 500,000 devices. 

The Automated Inventory license introduced in Enterprise Discovery 2.20 enables you to purchase inventory 
capability based on the number of devices that you expect to manage. This license replaces the Device 
Discovery and Device Inventory licenses provided in versions of Enterprise Discovery prior to 2.20. If you 
have purchased these two licenses for a previous version, you will have access to all features provided with 
the Automated Inventory license offered with version 2.51. Note that the Automated Inventory license is 
functional but is not yet reflected in the Enterprise Discovery user interface. 

Updated third party components 

• MySQL Enterprise 5.0.50 

• Apache Tomcat 5.5.26 
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New Features  
There are no new features in this release. This release contains some minor enhancements and several bug 
fixes. 

 
Enterprise Discovery 2.51 fully supports Agent, Scanners, and Software Utilization on Windows 
Vista SP1. 
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Obsolete Features 
All features in 2.50 are supported in release 2.51. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals/ 

1 Uncheck Show only my products if checked. 

2 In the Product list, click the product name (for example, Enterprise Discovery). 

3 In the Version list, click the version number. 

4 In the OS list, click the operating system type. 

5 Click Search. A document list is displayed that matches your search criteria. 

6 In the document list, click the document title. The document opens in your browser window. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

None of these guides have been reissued for release 2.51 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 
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Installation Notes 
Installation requirements and instructions for installing Enterprise Discovery are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery. Refer to the “Upgrading from Enterprise Discovery Version 2.1.x or 2.20” section 
in the “Upgrade and Migration Scenarios” chapter in the Installation and Initial Setup Guide for details. 

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.1.x: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

Version 2.2x: C:\Program Files\HP OpenView\Enterprise Discovery\2.2* 

Version 2.50: C:\Program Files\Hewlett-Packard\Enterprise Discovery\2.50 

4 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

5 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server, Service Pack 1 or Service Pack 2.  

Enterprise Discovery must be installed on a local disk. It cannot be installed on network drives, SAN drives, 
or clustered devices. Enterprise Discovery has been tested in a RAID (redundant array of independent 
drives) level 0 and level 1 environment. As a result, it has been determined that it can be successfully 
installed in a RAID level 0 or level 1 environment. 

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate so long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for Enterprise Discovery. For large networks, level 0 can also be used if performance is more important than 
fault tolerance. RAID level 5 is not currently supported. 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the Enterprise 
Discovery installation. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A
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Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000 
 

x x 7 
2+ CPUs or cores 
3.6 GHz 260 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 2 CPUs or cores 50 
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Memory 
(GB) CPU* 

Disk 
(GB) 

3.6 GHz 

* CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP Enterprise Discovery consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs and more memory may be required. 

 
Enterprise Discovery routinely performs many disk access operations. In order to improve 
performance, especially for networks with a large number of devices, it is recommended that you 
use fast access disks such as SCSI. 
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These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, 2003 or Vista 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

5.0 or 6.0 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in this current software 
release.  

Table 2 lists enhancements to existing features or behavior; Table 3 lists problems that were fixed. 

Table 2 - Enhancements 

Number Location Fix Description 

18374 UNIX Scanner A new hardware field, hwNICInterfaceName has been 
introduced to store the network interface name. The 
description field, hwNICDescription, that used to contain 
the network interface name on UNIX, has been amended to 
provide a detailed description of the network card. 

18433 Discovery Engine Scanner merging logic has been improved. The Device ID in 
the scanner merging logic is now optional and can be removed 
from the merging list if desired. Making the Device ID 
optional allows users to better customize their configuration. 

18456  Reports Status reports now allow you to see if the devices are being 
scanned or modeled according to schedule. 

18458 Aggregator The new hardware field, hwDateProcessed has been 
introduced. In the enriched scan file, it contains the date the 
XML Enricher processed the file. In the database, it contains 
the date the data was successfully imported into the database. 

18597 Reports Enterprise Discovery now works with the Configuration 
Management (CM) Report Server Engine 5.11. 

Table 3 - Problems Fixed 

Number Location Fix Description 

17503 Agent Utilization 
Plug-in 

The reporting of application utilization for those applications 
that were executed for a very short period of time is now more 
accurate. 

17606 Mac OS X Agent When the Mac OS X agent is running, using the agent 
installation disk image (.dmg) to upgrade an existing agent 
now commits the changes immediately. There is no need to 
reboot the system.  

17749 Administration > 
Discovery 
Configuration 

Clicking on an item under the Administration > Discovery 
Configuration > Scanner Configurations page of a remote 
server no longer launches the Scanner Generator for the 
aggregator server. 

18004, 18369 Viewer Installed application recognition no longer reports wrong 
application versions in some cases. 
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Number Location Fix Description 

18015 Linux Scanner Virtual network interfaces are now included in the scan file. 

18151 Administration > 
Discovery 
Configuration 

The Export functionality of the Discovery Configuration now 
works correctly when invoked from an aggregator for a remote 
server. 

18195 Server Devices are no longer incorrectly deactivated with the 
“License exceeded” reason. This some times occurred with the 
Topology license when there were a large number of clouds. 

18209 System Monitor The service-stop timeout value for the System Monitor has 
been increased to avoid “The service did not respond to the 
start or control request in a timely fashion” error. 

18236 Administration > 
Discovery 
Configuration 

In the Discovery Configuration, moving credentials up and 
down in SNMP, Virtualization, or Mobile configuration 
profiles are now taken into account immediately. 

18237 Windows Scanner In Windows Vista, the scanner now collects port information. 

18247 Server The reports database now contains the device to device 
connectivity information. 

18256 Network Map On large servers, the network map no longer disconnects. This 
problem occurred in rare cases only. 

18257 Agent 
Communicator 

Excessive CPU and I/O activity when executing the mobile 
device discovery has been reduced. 

18267 Linux Scanner Rated CPU value is now propagated to CPU 3 and 4 in the 
scan file. 

18271 Server When a VMware or mobile server is reactivated, the 
VMware/mobile discovery workflows are now triggered 
automatically based on the schedule. 

18278 Update Model > 
Query Device, 
Device Manager 

The Update Model > Query Device command is now enabled 
for mobile devices. 

18279 Mac OS X Scanner The Mac OS X scanner no longer uses a significant amount of 
CPU cycles when the debug mode is enabled. 

18285 SAI Editor Empty install strings are no longer added to the SAI. They 
are automatically removed. Empty strings could have an 
adverse effect on recognition. 

18292 Windows Scanner Device driver files are now detected correctly. The files now 
have the correct device drive attribute D included as part of 
their file attributes. 
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Number Location Fix Description 

18293 Linux Agent 
Utilization Plug-in 

Software utilization plug-in in Linux no longer corrupts some 
daily utilization data. 

18294 Agents The startup script for Mac OS X is no longer shipped with all 
UNIX agents. 

18295 Installation Support information for the agent shown in Add/Remove 
programs no longer references "support@peregrine.com." It 
now references “http://www.hp.com/go/hpsoftwaresupport.” 

18298 System Monitor The self-signed SSL certificate used to access the Web UI of 
the Enterprise Discovery server is now issued by Hewlett-
Packard instead of Peregrine. 

18299 Discovery Engine The thread processing problem that sometimes causes the 
Discovery Engine to hang has been corrected. 

18300 UNIX Scanner UNIX scanners no longer spawn several processes when an 
external command hangs. 

18301 Administration > 
Discovery 
Configuration 

Deleting a credential record from a VMware or Mobile profile 
no longer deletes the wrong one. 

18307 Reports Drill-downs from a Single Device report with no asset data no 
longer generate errors. 

18313, 18520 Installation During installation, individual packages part of the Discovery 
Knowledge, as well as the Discovery Knowledge itself, are 
now compared correctly and the most recent ones are selected. 

18315 Administration > 
Discovery 
Configuration 

The "Cancel" button in Credential Details page of 
Virtualization and Mobile Configuration Profiles now works 
properly. 

18325 Network Map The problem that caused the “Network Map Disconnect Error” 
to occur on some rare occasions has been corrected. 

18327 Applet The Virtual Devices window no longer shows the VM Status 
as "unknown". 

18329 Scanners The scanner no longer crashes when saving a log file to a 
remote location. This happened under certain occasions only. 

18331 Server The consistency check mechanism now works when 
performing high volume delete operations on the Aggregate 
database. 

18334 Solaris Scanner The misspelling of Solaris in the scanner banner has been 
corrected. 
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Number Location Fix Description 

18342 Administration > 
Discovery 
Configuration 

The SNMP V3 username credential is now case sensitive. 

18343 AIX Agent Software 
Utilization Plug-in 

There are no longer errors in the utilization agent plug-in log 
when “idle process” is parsed. 

18344 Topology Engine The Topology Engine no longer crashes while processing the 
time string with an invalid time value. 

18357 Windows Scanner The Scanner can now retrieve the shortcut details of certain 
non-standard shortcuts to programs that have a command 
line argument. 

18370 Viewer The Viewer is now able to go to all of the files found with Edit 
> Find File. 

18371 Analysis 
Workbench 

A warning about library inconsistency is no longer displayed 
when nothing has changed. 

18372 Analysis 
Workbench 

Sorting in the Details window no longer ruins the link up to 
the Directories window. 

18380 AIX Scanner Network card detection inconsistency on AIX has been 
resolved. 

18385 Server > Aggregate For an aggregator, the server error after logging in with the 
"Password expiry:" setting no longer occurs. 

18388 Scanners The problem that caused Extract Options to not be applied to 
the registry and environment extract asset fields in some 
occasions has been corrected. 

18389, 18390 Administration > 
Discovery 
Configuration 

Deleting a community string from the SNMP profile no longer 
deletes the wrong one. Also, editing an SNMP community 
string no longer corrupts the display list when returning to 
the main SNMP screen. 

18398 UNIX Scanner NFS3 mount network drives are now detected correctly and 
are not scanned. 

18403 Device Manager The UUID field for virtual device now correctly displays its 
UUID instead of the path name. 

18406 System Monitor The problem causing the Enterprise Discovery Server services 
to fail to start on rare occasions when the system is rebooted 
has been corrected. 

18408 Scanners The delta scanning logic has been corrected. 

18412 Scheduler The Aggregate database tables are now periodically optimized 
resulting in improved performance. 
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Number Location Fix Description 

18415 UNIX Agent Only critical scanner/agent errors and agent deployment 
details are now captured to the UNIX log file so that the file 
does not grow too large. 

18430 Server Duplicate IP and MAC addresses that belong to the same 
device in the Discovery database no longer cause Inventory 
import into the Aggregate database to abort. 

18436 Server MTTR and MTBF reporting thresholds are now working 
correctly when set to the default values. 

18439 Web UI When starting Enterprise Discovery in the Internet Explorer, 
the ”unsecured image” error no longer occurs. 

18442 XML Enricher The Application description field (which can be set for an 
application in the SAI Editor or Analysis Workbench) is now 
imported into the Reports database. Previously this field in 
the database was always empty. 

18449 Server > Admin > 
Discovery 
Configuration  

The Import button no longer needs to be pressed twice to 
import data. 

18463 Applet > Model 
Update 

Device Manager > 
Model Update 

In the applet, as well as in the Device Manager, agent and 
scanner deployment workflow commands are now correctly 
enabled based on the configuration. 

18481 Status > Device 
Status 

Status reports no longer show inconsistencies between the 
summary and the detailed view when applying filters. 

18483 Notification > E-
mail 

Links in e-mail event notifications now use the name 
configured in system preferences. 

18486 Scanners When the Delete Invalid Characters option is selected in the 
scanner, the scanner no longer fails. 

18496 Network Map On upgrades from Network Discovery, the map no longer fails 
to open when an unsupported background color was used.  

18505 Database An account named "Carl" no longer appears in the MySQL 
default user accounts. 

18510 Administration > 
Event Filter 
Configuration 

The changes made to the State Transition fields when 
modifying the Event Filter Configuration now persist. 

18519, 18590 Scanners The scanner no longer fails when scanning a directory with a 
% somewhere in its name. 

18524 Notification Entering multiple device IP addresses in the Event Filter no 
longer causes the Event Manager to crash. 
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Number Location Fix Description 

18526 Scanner Generator The Scanner Generator setting Scanner Options > Always 
Create Log File that was accidentally omitted in Enterprise 
Discovery 2.50 has been re-introduced in this release. 

18530 Scanners Some SMBIOS fields that can occur multiple times per record 
are now added. 

18557 Server Performance has been improved around database connections. 

18561, 18577 Event Manager Events are no longer listed with erroneous future timestamps. 
The events with invalid timestamps are eventually aged out 
and are deleted on the local servers but not on the Aggregator. 

18564 Administration > 
Discovery 
Configuration 

In the Import/Export screen, the Export button works as 
expected in FireFox. 

18581 Aggregator The Aggregator now allows remote Enterprise Discovery 2.2x 
and 2.50 servers to be aggregated. 

18594 Device Manager The caption in Device Manager "NetBIOS name (scan)" has 
been changed to “Computer name (scan).” 

18595 Windows Scanner The hwDomainName field on Windows incorrectly contained 
the domain of the currently logged in user, not the domain of 
the computer. This has been corrected. A new field, 
hwNetworkLogonDomain has been introduced to store the 
domain of the currently logged in user. 

18602 Windows Scanner When the device driver hardware detection is enabled, the 
scanner no longer exits prematurely in certain circumstances. 

18603 Reports Optimizations have been made to the Unrecognized File 
Reports. 

18623 Scanner Generator The Directories tab no longer disappears from the Software 
Details page. This problem occurred on some occasions only. 

18637 Solaris Scanner If the Solaris scanner was configured with a maximum 
random delay of one hour, the actual delay no longer exceeds 
this one hour limit. 

18689 Database The list of recognized file executable types has been expanded. 

18694 Event Browser The Back and Forward buttons in the Event Browser now 
work properly. 

18707 Scheduler Counts associated with file data are now verified every 
minute instead of every 5 seconds to improve performance. 
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Number Location Fix Description 

18709 Analysis 
Workbench 

If a row in the Details Window (for a file) is highlighted and 
scan files are unloaded, the Details Window is now cleared 
and clicking on rows in this window no longer causes access 
violations. 

18724 Server Several issues with the Aggregate database consistency have 
been corrected. 
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Known Problems, Limitations, and Workarounds 

Agents 

• The agent upgrade process on Solaris 9 may take a long time (SCR# 16663). 

• On Mac OS X 10.4.10 or above (Intel), there may be a problem with contacting the agent because it can 
be blocked by a firewall. The agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration (SCR# 
17960). 

• When you install the agent on Windows Vista machines not using the "Administrator" account, the 
firewall exception is not added into the exceptions list (SCR# 18252).  

Scanners 

• In Manual Deployment Mode, the UNIX scanner will not save offsite scan files to an FTP server when 
the user name is specified in the form domain name/user name (SCR# 12893).  

• Automounts are being scanned in HP-UX and Linux systems (SCR# 15950).  

• Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

• When a user is connected to a machine through a terminal session, the scanner launched in the manual 
deployment mode gets data related to the session rather than the actual video card data. Also, the video 
card and video memory are not detected properly (SCR# 17528). 

• The scanner does not take into account the Files to Scan > Attributes option configured through the 
Scanner Generator (SCR# 17992). 

• The scanner does not take into account the "Only store files smaller than" option for stored files 
configured to be collected from a “Specific directory” in the Scanner Generator (SCR# 18017). 

• The Windows Vista Service Pack 1 is not detected properly on x64 versions of Windows Vista (SCR# 
18746). 

• The Mac OS X (x86) scanner does not collect detailed CPU cache information and the logical CPU count 
is not correct for dual Core CPUs (SCR# 18754). 

• The Mac OS X scanner does not collect information on cards and USB data (SCR# 18755). 

• The following new Windows operating system versions may not be identified properly as part of the 
hardware data displayed in the Enterprise Discovery Viewer. These also include x64 versions, where 
available (SCR# 18774): 

— Windows Vista Home Premium Edition N  

— Windows Vista Enterprise Edition N  

— Windows Vista Ultimate Edition N  

— Windows Server 2008 Server Standard Edition (core installation) 

— Windows Server 2008 Web Edition (core installation)  

— Windows Server 2008 Standard Edition without Hyper-V (full installation)  

— Windows Server 2008 Datacenter Edition without Hyper-V (full installation)  

— Windows Server 2008 Enterprise Edition without Hyper-V (full installation)  

— Windows Server 2008 Standard Edition without Hyper-V (core installation) 
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— Windows Server 2008 Datacenter Edition without Hyper-V (core installation)  

— Windows Server 2008 Enterprise Edition without Hyper-V (core installation) 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (SCR# 15827). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

Server Installation 

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370). 

• After an uninstall, the branding registry keys are leftover (SCR# 15507).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(SCR# 16520 and SCR# 17016). 

• Enterprise Discovery with a Network Topology license should not be installed on VMware (SCR# 16524). 

Server 

• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (SCR# 13964). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the "Listen 80" directive in the httpdf.conf file (SCR# 14808).  

• An older OpenSSL DLLs in the system PATH can affect the Enterprise Discovery Apache server and 
Perl engines (SCR# 16318). 

• In some cases, the event notification delays configured in filters are not taken into account (SCR# 
18528). 

Aggregation 

• For aggregation to fully function, the version of the Enterprise Discovery Server that is being aggregated 
must be identical to that of the Aggregator. That is to say that if the Aggregator is running version 2.51, 
the aggregated servers must also be running 2.51 (SCR# 18740). 

Web User Interface 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" option in Discovery Configuration may 
not have any effect (SCR# 14388). 
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• The password for the default "demo" account does not conform to the account/password validation rules 
(SCR# 18238). 

• Under Administration > System Configuration > Server Passwords, if the password history flag is set 
to "0", setting the same password on the account does not work when done twice within 5 minutes (SCR# 
18239). 

Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (SCR# 13803).  

Web Asset Questionnaire 

• The UI may show non-printable characters in text fields (SCR# 16285). 

• In Internet Explorer, when connecting to the main page through a proxy server, the "You are connecting 
from" IP address reported will be the IP address of the proxy server not that of the remote computer 
address (SCR# 17870). 

Applets 

• Pasting information in any Find dialog box does not work when using the SHIFT+INS key combination 
(SCR# 18235). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (SCR# 16041). 

Integrations 

• UTF8 Enterprise Discovery data may not display correctly when viewed through the Configuration 
Management (CM) Reporting Server 5.10 (SCR# 18273). 

Internationalization 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (SCR# 17180). 

• NetBIOS information collected by the network models will be displayed incorrectly if the string has non 
ASCII characters (SCR# 17411). 

• There are several problems with the SAI Editor accepting characters in the Korean code page (SCR# 
18126, SCR# 18127. 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (SCR# 18144). 
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• Various UI screens (reports, status reports, Device Manager, and so on) format the "day of the month" 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (SCR# 18218). 
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